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Introduction
Congratulations on your selection of ScorePAD Baseball.  ScorePAD Baseball is
the first comprehensive scorekeeping software system for the Palm Connect
Organizers, Handspring Visors and other Palm OS compatible hand-held
computers.  ScorePAD gives you at-the-park electronic baseball scoring that is
actually easier to use than paper.

With ScorePAD you can keep score while gathering and maintaining statistics.
Scoring and gathering statistics are one in the same since ScorePAD compiles
statistics from each pitch of each atbat, from each defensive play, and each ball
put in play.  In addition, ScorePAD’s conduit allows you to move completed
games to your personal computer using Windows 95 or Windows NT during a
process called HotSync.

ScorePAD Functionality

ScorePAD provides:

q Automated scoring on a small hand-held computer
q Visual similarity to paper scoring systems
q Automated prompting for all scoring information
q Automatic statistics gathering and calculation
q Windows 95/NT software for permanent storage and printing
q Roster management for players and their season statistics
q Optional Major League Baseball season statistic updates

ScorePAD Benefits

ScorePAD offers you the following benefits:

q Using ScorePAD feels natural to the experienced scorer and yet easy
to learn for the beginner.

q ScorePAD’s paper-score-sheet-like interface helps keep you in familiar
territory while remove most of the complexity of paper.

q ScorePAD gives you the best of both worlds; an interface you already
understand and more information than you would ever calculate using
paper.

q ScorePAD allows you to store team rosters and statistics on you Palm
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along with games played for an entire season.  With ScorePAD and
RosterPAD,  you can score and keep stats for an entire season right on
your Palm - if you choose.

q Added features like infrared beaming of games, lineups, and rosters
along with laser printing of score sheets, stats and spray charts  make
it difficult to imagine any advantages paper scoring might provide.

Alegis Technologies hopes that using ScorePAD and RosterPAD adds to your
total baseball experience.  Regardless of the level of baseball, the process of
scoring increases your knowledge and enjoyment of the game.
The Baltimore Orioles Program Scorecard contains the following warning:

Warning! Be careful.  Scoring a ball game can be habit forming.  Proceed at
your own risk.

About this manual
This manual assumes that you know how to use the Palm OS device.  It also
assumes that you have a basic knowledge of baseball scoring terminology and
procedure.  If you haven't acquainted yourself with the Palm OS device, Graffiti,
menus, shortcuts, HotSync, or other terminology or procedure associated with
the Palm OS device, please take time to read the Palm OS Handbook and go
through its tutorial.

If you don't understand baseball scoring procedure and terminology we
recommend you obtain a copy of the book The Joy of Keeping Score by Paul
Dickson.  This book contains the history and instruction on keeping score while
watching a baseball game.  You can obtain a copy from  most major book
stores.
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Installation

Windows Software

Whether you install ScorePAD from diskettes, CD, or downloaded file, the
procedure, other than disk swapping in the case of a diskette installation, is the
same.

The installation takes you through seven dialogs:

q Welcome
q End User License Agreement
q Registration
q Destination Directory
q Installation Progress
q Finish

Welcome and finishes are just cordial status pages.  Let's take a look at the rest.

End User License Agreement (EULA)

Please take time to read this dialog.  The EULA details the legal conditions of
use under which Alegis Technologies, Inc. grants you a ScorePAD license.  You
will want to take care not to violate any of these conditions since the criminal
and civil penalties for such violations can be costly.

Press the Yes button on this dialog if you agree with the EULA.  If you disagree,
Press No.  If you press No, the installation will stop.  If you press Yes, the
installation will continue and you will be legally bound by the terms and
conditions of the EULA.

Registration

The registration dialog prompts you to enter your name, company or organiza-
tion, and the serial number you received with your copy of ScorePAD.  You
must enter information in all three of these fields.  Once you've completed the
registration form, you may proceed to the Destination Directory page.
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Destination Directory

The Destination Directory page allows you to select the directory to which the
install program will copy ScorePAD.  You may change this directory to any
directory you prefer.  The default directory is as follows:

C:\Program Files\Alegis Technologies\ScorePAD Baseball\

Installation Progress

The installation progress dialog shows you the progress of the installation as it
continues.  If you are installing ScorePAD from diskettes, the installation
program will alternate between the Install Progress dialog and dialogs prompt-
ing you for each diskette until the installation completes.

Palmtop Software

In addition to installing ScorePAD's Windows software on your PC, the install
process will copy the files ScorePAD.prc and RostrPAD.prc into your Palm OS
directory (usually C:\Pilot or C:\Palm).  You must use the Palm Install Tool to
install these PRC files onto your Palm OS device.  Complete the following steps
to perform the Palm OS install:

1. Run the Palm Desktop Install Tool application on your PC in Windows
95/98/NT4 by selecting Palm Desktop from the Programs section
of the Start menu.

2. Select the Palm Install Tool from the Palm Desktop submenu.
3. Once in the Palm Install Tool, press the Add button.
4. After the Open dialog appears, Select ScorePAD.prc then hold down

the Ctrl key and select RostrPAD.prc
5. Press the Open button.  ScorePAD.prc and RostrPAD.prc will appear

in file list of the Palm Install Tool main dialog.
6. Press the Done button on the Palm Install Tool main dialog.
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Palm Install Tool

Completing the installation process

To complete the installation process, you must perform a HotSync operation
with your Palm device.  The HotSync process will install ScorePAD and Roster-
PAD on your Palm device.

To verify that the installation process worked, touch the Applications button
to the left of the Graffiti writing pad on your Palm OS device.  You should see
RosterPAD and ScorePAD among the applications installed.
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The Game Setup View

Game Parameters Dialog
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Starting a game

Game setup

Once you've loaded ScorePAD and RosterPAD on your Palm OS device, you are
ready to setup a game. The installation process creates a blank game for your
convenience. To setup a game you must complete the following steps:

1. Enter the abbreviations of the home and visiting teams
2. Set game start date and time
3. Enter field name, weather conditions, and officials' names
4. Select players in starting lineup for each team
5. Set players' defensive positions

Entering game information

To enter game information you must use the Game Setup view.  To move to the
Game Setup view from the ScoreCard view, select Game Setup from the Op-
tions menu.

The teams

First, you will need to set the visiting and home teams. Enter the team names
using Graffiti. The dates and times will default to the current day and time. To
set the visiting team you simply erase the default text Vis and use the Graffiti
tablet to write a valid team name.  For example, ATL is the abbreviation that
Major League Baseball uses for the Atlanta Braves.  Similarly, to set the home
team, erase the default text Hom and write the home team's short name; for
example FLA for the Florida Marlins.

Game duration

The Game Setup view only requires that you enter the team abbreviations.
However, you may also record the game's duration.  To record the game's
duration, enter the starting time of the game by touching the Start Time field
and setting the time.  As the game progresses, the ScoreCard and Game views
will display the game's duration in hours and minutes.  In addition to setting the
start time here, when you record the first pitch, ScorePAD gives you the
opportunity to set the game clock's starting time to the time of that pitch.
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The End Time field allows you to set the ending time of the game.  ScorePAD
will prompt you after the last play of the game to set the end time to the
current time.  Once the End Time is set, you cannot add anymore atbats to the
game.  The Delay Duration field allows you the set the total hours and
minutes of delay in the gamel.

Other game information

You may also use Graffiti to enter the stadium or field, a description of the
weather, the official scorer, the condition of the grounds, the number of fans in
attendance, and names of up to four officials.  Although ScorePAD will save and
HotSync all of the information you enter in Game Setup view, Visitor and Home
fields are the only required fields in this view.  Once you have completed your
selections, touch the Done button to return to the ScoreCard view.

Creating a new game

ScorePAD will store as many games as your Palm OS device has free memory.
If the Home field contains the team name Hom and the Visitors field contains
the team name Vis, you have not setup ScorePAD's current game. You may
setup and use the current game to start scoring.  If you've already used the
current game and wish to create a new game, select Create New Game from
the Options menu of the Game Setup View. The Game Setup view will clear.
ScorePAD will then set the visiting team to Vis and the home team to Hom.
You can now enter team abbreviations and begin scoring in the newly created
game.

Erasing the current game

When ScorePAD erases a game it removes all of the atbats and lineups of the
game.  If you start scoring a game and decide you don't want to keep the atbats
or lineups of that game, you might want to erase it and score another game.  To
erase an existing game you must select Erase Game from the Options menu
of the Game Setup view.  You will have the choice of erasing only the atbats of
the game or erasing everything including the teams and lineups.   Erasing only
removes the game information.  To totally remove game from your Palm device
you must delete the game.

Warning: If you intend to keep any of the information from a game
you plan to erase, you must perform a HotSync operation with the
ScorePAD Desktop before erasing the game.
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Selecting another game

ScorePAD identifies the current game by the number to the left of the title bar.
To select another game, touch the number.  A list will appear containing the
teams and dates of each of the games stored in ScorePAD.  Touch the game you
want from the list and that game becomes the current game.  The ScoreCard
view contains the same mechanism for selecting games.

Deleting a game

When ScorePAD deletes a game, it removes all information about that game
from you Palm OS device's memory.  To delete a game, you must select Delete
Game from the Options menu of the Game Setup view.  After selecting
the menu item, ScorePAD will prompt you to confirm the delete.  If you answer
Yes, ScorePAD will permanently remove the current game from your Palm
device.  There is no way to recover a deleted game.  ScorePAD will not allow
you to delete a game if you only have one game on your Palm device.  You must
have at least one game on your Palm device at all times.

Game Parameters

Game Parameters Dialog

The Game Parameters dialog adds the capability of scoring games that don't
conform to Major League Baseball rules. You can set the following special game
parameters:

q Home team league
q Visitors team league
q Number of home team lineup players
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q Number of visiting team lineup players
q Game type
q Scheduled Innings
q Series ID
q Initial Count
q Pitcher Bats checkbox
q Free Form checkbox
q Add players to database checkbox

To access the Game Parameters dialog, touch the Game Parameter button
on the Game Setup dialog.

Leagues

Leagues in ScorePAD equate to categories in RosterPAD.  Since most youth
baseball leagues use a common set of team names, mostly Major and Negro
league team names, RosterPAD employs the use of leagues to distinguish teams.
If your child plays in My Park on the Astros and you are playing the Their Park
Astros, You might create My Park and Their Park Leagues in RosterPAD and add
each player to their respective league.  You might also create a league for each
age group within a park (i.e. 9-10 My Park) ScorePAD allows you to pick from
those leagues on the Game Parameters dialog.

Number of lineup players

With some free substitution rules, all of the players on the team become part
of the batting rotation though they may or may not play defensively.  To accom-
modate this scenario, ScorePAD allows you to set the number of lineup players
for each team.  Since ScorePAD automatically moves from the current batter to
the next logical batter, you must set the exact number of batters on each team.
If the pitcher isn't batting, still include his position in the number of lineup
players and uncheck the Pitcher Bats check box.

Game type

You can set the game type to any of eight descriptions.  This will allow both the
ScorePAD Desktop and Palm to compile statistics by game type.  The param-
eter will default to Season.

Scheduled innings

You may set the number of scheduled innings for each game.  When the players
have completed that number of innings without a tie, ScorePAD will automati-



17

cally mark the game as complete.  ScorePAD will prompt you to set the game's
End Time after the last out of the last scheduled inning or after the winning run
scores in bottom of the last scheduled or any extra inning.

Series ID

The series ID identifies a game as belonging to a specific series.  Selecting an ID
for each series will allow ScorePAD to compile series-oriented statistics.

Initial count

In some softball tournaments, the batter comes to the plate with an initial
count.  ScorePAD allows you to set the initial count to any of the following
counts:

0 Balls, 0 Strikes
1 Ball, 1 Strike
2 Balls, 2 Strikes
3 Balls, 2 Strikes

ScorePAD adds balls and strikes to bring each batter that comes to the plate to
that initial count.  You can change the initial count at any point during the game
by returning to the Game Parameters dialog.

Free Form checkbox

The Freeform check box allows the scorer to score any atbat on the entire
score card.  If you want to only score the atbats of a single player during the
game, you may use free form mode.  As the game progresses you touch the
square of the score card that represents the atbat of the play in the current
inning and ScorePAD presents the proper GSP view.

If you come to a game late, you may use freeform mode to catch up and then
switch to the standard mode.
In freeform mode, ScorePAD doesn't keep score or keep track of outs.

DH may be used checkbox

When a team uses designated hitter (DH) that hitter bats in the place of a
defensive player.  In Major League Baseball that player is always the pitcher.
Whenever a team uses a DH, check this box and place the defensive player for
which the DH bats in the last lineup slot.  This will allow ScorePAD to gather
defensive statistics for that player without placing him or her in the batting
order.
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When you've checked the "DH may be used" checkbox, a lineup slot will appear
at the end of the score card that has no atbat squares adjacent to it.

Add players to database checkbox

This flag tells ScorePAD's conduit whether or not to add any penciled-in players
to your desktop RosterPAD database.  If you check this box, any players you
add to the game using the Edit Lineup dialog will be added to RosterPAD's
desktop database during your next HotSync.  If you've performed a Save Lineup
operation for a given team,  that teams players have already been added to
RosterPAD's database.

This flag is automatically turned off when you start  ScorePAD.

For teams that you don't expect to face again, you will want to leave this box
unchecked.  Once players are added to the desktop RosterPAD, they will
HotSync down to the Palm RosterPAD database.  Once you add players to your
Palm's RosterPAD database, they will be added to the desktop Roster database
during the next HotSync operation.  No matter which way you add player to
the Roster database, they will end up on both the Palm and desktop Roster
databases.
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Score Card Full Game view

Score Card Player Detail view
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Filling in the score card

The ScoreCard view

The ScoreCard view displays the status of the entire game.  This view shows
you the following game information:

q Game number
q Opposing teams and scores
q Player's name, number, & defensive position
q Game duration
q Individual atbat results for each player
q Current inning and batter

Each individual square on the ScoreCard view represents an atbat.  ScoreCard
squares graphically represent a number of events that occurred during that
atbat.  The graphic below shows each graphic component of the an atbat
square and the event that it represents.

The ScoreCard view has two modes Full and Detail.

Full Game mode

The full game view shows you nine players and up to nine innings.  If you have
scored one to six innings, this view shows player full last name and defensive
position.  During the seventh and eighth innings, the players' last names are
reduced in size.  After scoring nine or more inning, the defensive position is
removed from this view.  You can still change the defensive position in the
Player Detail mode of this view or the Edit Lineup view.
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Player Detail mode

In the Player Detail view you see the players' numbers, complete last names, first
initials, defensive positions, four innings of atbats across, and seven players
down.  The Player Detail view allows you to see and change player defensive
positions and, in the case of a ten or more player team, scroll to the lower half
of the ScoreCard and change the 8-14 players.

To scroll down in the detail mode, touch the lower area of the score card.  You
can identify this area by the lines extended below the seventh player.  To scroll
right in the detail mode, touch the area to the right of the last displayed inning.

Creating the starting lineup

ScorePAD automatically loads the rosters of the teams you select in the Game
Setup dialog.  At the ScoreCard view you will select the lineups for each team.

If you have never saved the starting lineup for either team, no player names will
show up on the score card.  If you have saved a starting lineup for the current
team, the last saved lineup will automatically appear on the Score Card view.

To select lineups you must:

1. Select the team
2. Select a batting order
3. Select a defensive position for each player

Selecting a team

In the Title Bar, ScorePAD displays the team names, and scores.  These name/
score displays serve a dual purpose.  In addition to showing the current scores,
they serve as buttons to select team cards.  By touching either team, you select
that team's score card.  The selected team will appear in reverse.  In the
example below, Atlanta (ATL) is selected.
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Selecting players

To select a player when RosterPAD players have been pre-entered:

1. Touch the batting slot you wish to change.

2. A list box will appear with the names of all players entered for that team.
The player list box will show position players first, then pitchers.  Each list is in
alphabetical order.

3. Touch the name of the player you wish to place.
Once you've selected a player for each slot in the batting order, the lineup is
almost complete.

If you haven't entered any players for the selected team into RosterPAD, the
Edit Lineup dialog will appear.

The Edit Lineup dialog

For teams that have not been entered into RosterPAD, use Edit Lineup to enter
player numbers and names.  You can also use the Lineup dialog to "pencil in"
players even if most of the selected team's players have been entered into
RosterPAD.

You can access the Lineup dialog from both the Score Card and GSP views.  To
access the Lineup dialog select Edit Lineup from the Options menu on either
view.

Lineup view
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Moving players around in the lineup

Touch player to move Drag pen to destination slot Lift pen

The Score Card view provides a graphical interface for moving players around
in the lineup.   This operation is very useful for minor batting order changes
from day to day.  You can only move a batter if that batter and all batters
between that batter and the destination slot have no atbats.  You should only
use this function during the first few innings of the game.

To change a players batting slot:

1. Touch the players name.

2. While holding down your pen, slide the player to the destination batting slot.
Batting slots will highlight and unhighlight as you move your pen over them.

3. When the destination batting slot is highlighted, lift your pen.  The player will
move to that batting slot.

Setting defensive positions

Finally, you must set the defensive positions of your lineup. Only the Detail
mode of the ScoreCard view allows you to set a player's defensive position.
ScorePAD makes this task just as easy as setting the lineup.  Touch the box to
the right of player's name.  A list box will appear with all defensive positions
recognized by ScorePAD.  Click on the correct defense position and it's set.  You
should have one and only one pitcher per lineup.  If no pitcher is selected
pitching stats are credited to Unknown Pitcher.

When you've selected defensive positions for each player, you have completed
the starting lineup.
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Creating lineup without RosterPAD data

In some cases, (e.g. tournaments) you do not have rosters for opposing teams.
In these cases you can use the Lineup view to create and edit ScorePAD
lineups.

To move to the Lineup view, select Lineup Edit from the Options menu of
the Score Card view.

You must enter player numbers for each player in the lineup.  Last name, first
name, and position are optional.  If you enter a play number and RosterPAD
has team data, the Lineup view will automatically fill the name and position
fields.  If your lineup has more than 10 players, you may use the scroll bar on
the right to scroll to the remaining players.

Saving the starting lineup

If you've scored professional baseball games, you've probably recognized that
starting lineups don't change very much from game to game.  ScorePAD gives
you the benefit of saving the starting lineup for a given game to use for the next
game you score.

To save the starting lineup:

1. Select Save Lineup from the Options menu.
2. ScorePAD will prompt to save either or both of the teams' lineups.
3. Selected the lineup(s) you want to save

ScorePAD will update your RosterPAD database with the defensive position
and batting slot of each starting player for the team(s) you select.  If any of the
players don't exist in RosterPAD's database, ScorePAD will add them.

The completed score card

When you've completed the starting lineup, the ScoreCard view resembles the
illustrations of score cards at the beginning of this chapter.  The ScoreCard view
will show each player's number and defensive position.  Since you haven't began
scoring the game, the grid of atbats for all innings and all players will be blank.
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Player substitution

As each team substitutes players, you must make changes to your score card to
reflect those substitutions.  Changes in the lineup take place in two forms;
straight and double switch.

q In a straight substitution, one or more players enter the game in the
same batting order and defensive positions as the players they re-
placed.

q In a double switch, two or more players enter the game but in different
defensive positions than the players they replaced.

A coach usually decides to perform a double switch when the pitcher is
scheduled to have an atbat in the next inning but the coach wants a position
player to bat in that spot instead.

With ScorePAD you can substitute any player for any other player.  You can
also make any changes in the batting order.  ScorePAD maintains statistics for
all players that participate in a game whether starting or substitutes.

To substitute a player in ScorePAD, touch the name of the player in the batting
slot for whom you want a player to substitute.  When the list of team players
appears, touch the name of the player entering the game.  If the team of the
player being substituted, has not been entered into RosterPAD, the Edit Lineup
dialog will appear.  This dialog allows you to change the names, player numbers,
and defensive positions of any player in the lineup.  If the player being taken out
of the game hasn't had an atbat, ScorePAD will prompt you as to whether this
change is a correction or a substitution.  Once you answer the prompt, the
substitution or correction will take place.

Making substitutions in the GSP

You can perform two types of substitution in the AtBat or GSP view:

1. Pitcher substitution (straight only)
2. Pinch hitter
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To perform pitcher substitution:

Hold pen down on pitcher's  Select new pitcher from list
mound for 2 seconds

To select a pinch hitter, perform the following steps:

Hold pen on home base for Select the pinch hitter from
2 seconds, list will pop-up player list

The new pinch hitter
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The Lineup Wiz

The Lineup Wiz

The Lineup Wiz is a graphic view of a team’s batting order and defensive
assignments.  This graphic view gives you the power to do the follow for both
teams:

o Assign players to the batting order
o Drag-and-drop players up and down the batting order
o Drag-and-drop player from the batting order to defensive positions
o Select players from the roster directly to defensive positions
o Drag-and-drop players from one defensive position to another
o Discern which defensive position are not filled
o Discern which defensive positions have more than one player assigned

You can get to the Lineup Wiz in the following ways:

1. By selecting  Lineup Wiz from the Options menu of the ScoreCard view.
2. By pressing the “d” button on the left side of the GSP view.
3. By pressing Go to Lineup Wiz button when ScorePAD prompts you before
the first atbat of each half-inning whenever the team going on defense doesn’t
have all of its defensive positions assigned.

Assigning players to the batting order

You can assign players to the batting order of the Lineup Wiz in the same way
you assign players in ScoreCard view.  Touch the Position to which you want a
player assigned.  If that player’s team has a RosterPAD database, the Lineup Wiz
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will display a list of players.  Touch the player you want to assign to complete
the operation.  If the team doesn’t have a RosterPAD database, the Edit Player
dialog will appear allowing you to use Graffiti to write-in the player’s number,
last name, and first name.  You can use your pen to select from a list of defen-
sive positions.  Only the player number is required.

You can also assign a player to the next open batting slot by touching a defen-
sive position, then selecting or writing in a player.  This action assigns the
defensive position you touched to the player you selected and adds that player
to the next open batting order slot.  This feature is handy when you don’t have
a lineup card but you can see the players in the field.  You always use drag-and-
drop to change the batting order as the players come to the plate.

Dragging players to defensive positions

Once you set the lineup, you can drag players in defensive positions by touch
the player, holding down your pen, and dragging the player onto a defensive
position.  You can tell that a defensive position is unassigned when it appears
highlight on black and white displays or red on color displays.

Dragging players around the lineup

You can move players up and down the lineup by dragging them with your pen.
To change a players lineup position, touch the player with your pen, drag the
player to a new lineup slot and lift your pen

The player you want to drag, the destination, batting slot, and all of the players
between the two must not have had an atbat.  This feature come in handy when
you know the defensive setup but don't know the batting order.  You can set
the defense while the team is in the field, then drag-and-drop players into their
proper lineup slot as they come to the plate.

Swapping defensive positions

You can swap defensive positions between to players by dragging from one
defensive position to another.   If the destination defensive position isn't
assigned, the dragged player will be assigned to the destination defensive
position and the original defensive position will become unassigned.

Discerning open and duplicate defensive positions

When a defensive position is open it will appear in reverse on the right side of
the Lineup Wiz.  When a position is assigned to 2 or more players, the position
abbreviations next to each player will appear in reverse (red on color displays)
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GSP view with batter at plate

GSP view when batter reaches base
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Scoring an atbat

The GSP view

Alegis designed the GSP view to include almost every detail of the current
atbat. Features of this view include the following:

q Player name and number
q Player game atbat stats
q Player batting order
q Ball & strike count
q Pitch sequence
q On base results
q Out results
q Base advances
q Batting hand of batter
q Pitch count
q Game score
q Inning and batter count
q Pop-up access to pitcher season and game stats
q Pop-up access to player season and game stats
q Pop-up access to inning totals for both teams
q Pop-up access to lineups and 0-fors for both teams
q Access to pitch detail
q Access to other atbat details
q Access to previous and next atbats

Since you will spend most of your scoring time in this view, we have made AtBat
the "Game Situation Panel" for the scorer.  This view represents a single square
on the typical score sheet.  As you finish scoring an atbat, ScorePAD calculates
and moves to the next logical batter.  ScorePAD continues to move to the next
batter in the batting order until three outs are recorded.

As the teams switch between offense and defense, ScorePAD keeps track of the
batting order and automatically presents you with the proper player for the
upcoming atbat.  ScorePAD also recognizes when the last batter of the last
inning should return to the plate in the next inning.  This happens when his
atbat is interrupted by a teammate making the third out before his atbat is
complete (for example, caught stealing, picked-off, etc.)
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The scoring square

The GSP view represents a single atbat.  This view has the characteristics of a
single grid square on a paper scoring sheet.  If you have used a baseball scoring
pad, you will recognize the layout.

Pitch buttons

Along the right side of the atbat square you will notice buttons: Ball, Strike, Foul,
POA (Pick-off Attempt), N (No Pitch), Prev, and Next.  The first five buttons
allow you to record pitches counted against a pitcher's pitch count; the other
two move you to the previous and next atbats.  You can set Preferences to
include only balls and strikes in the pitch count.

Batter information

Along the top of the GSP view, the title bar of each atbat contains:

q Player number
q Player name
q Player batting slot
q Player game batting record
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pitch count
atbat result

pitch sequence

Number Name Hits Atbats
Batting
Order

Inning & outsScore

Game/atbat status

The GSP view shows game status on the line directly below the title.  The right
side of this line shows the visitor's team and score followed by the home team
and score.  The left side shows the inning half, inning number, and the number of
outs.

Below the AtBat square you'll find the result line.  The result line contains a
verbal description of the AtBat result.  This line exists to help make an associa-
tion between some of the abbreviations in the scoring square and generally
understood baseball terminology.

Pitch line

Under result line you'll find the pitch line.  On the left, the pitch line displays the
pitch result sequence.  You will see one letter for each pitch using the following
mnemonics:

q B = Ball
q S = Strike - swinging
q L = Strike - looking
q F = Foul
q P = Pick off attempt
q N = No pitch
q I = Ball put in play
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On the right side of the pitch line you will find the pitch count.  The pitch count
shows the number of balls (B), strikes (S), and total (T) pitches.  Balls and strikes
won't always add up to the total since ScorePAD includes No Pitches and Pick-
Off-Attempts in the total pitch count. Since they are neither balls nor strikes,
ScorePAD won't include Pick-Off Attempts or No Pitches in either B or the S
counts.

Atbat result buttons

You'll find the result buttons Out, On Base, and Advance at the very bottom
of the GSP view.  While you record balls and strikes you will see the Out and
On Base buttons at the bottom of the view.  Once the player has reached
base, the Advance button takes the place of the On Base button.  To record
an atbat result, touch Out or On Base and pick from the list of results.

Visual cues

This view also gives you visual cues that show more game information.  The
AtBat visual cues are:

q Shaded squares for each occupied base
q Darkened base paths for those run by batter
q A line to show the destination of the ball put in play
q Darkened ball and strike squares
q Square around hit or walk indicator, where applicable

Visual cues increase your enjoyment of the game as you score.  They show the
game/atbat status at a glance thereby increasing the time you spend actually
watching the game.  ScorePAD automatically generates these graphical indica-
tors with the exception of some ball put in-play destinations.

Scoring procedure

In ScorePAD, a game is simply the aggregate of all of its atbats.  ScorePAD atbats
contain:

q Pitcher
q Pitch sequence
q Pitch results
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Balls

Strikes

q On-base and/or out reasons
q Base advance reasons and players
q Destination of ball put in play
q Pitch detail

To score an atbat, follow the steps below:

1. Record balls and strikes by pressing the appropriate buttons
2. Touch either the Out or On Base buttons
3. Choose the on-base or out type
4. Touch on playing field to show where batter hit ball
5. Touch the Advance button to move batter around bases or drag-and-

drop runners
6. Touch the Out button and reason to show batter out on-base

Recording pitches

Since you'll spend a great deal of time watching and recording balls and strikes,
we wanted to make this as simple and as flexible as possible.  Some scorers are
used to the routine of looking up for the pitch and looking down to record the
pitch (some for several decades.)  If you want to maintain that habit you can
either touch the one of the five pitch buttons,

or touch the area that graphically displays balls and strikes,

If want to watch the game without looking down for every pitch, touch the
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proper pitch buttons to record pitches.  You will probably have to look down at
them at first.  After memorizing the buttons you will enjoy looking at the game
and touching the proper button to record a pitch.

The Palm OS device hardware buttons only work this way in the GSP view of

ScorePAD.  To move to other Palm OS device applications, touch the Card
button to move to the ScoreCard view.  Once in the ScoreCard view, the
buttons will work as normal.

You can configure the hardware buttons in the GSP view.  Select Button
Preferences from the Options menu to bring up the Button Preferences
dialog.    You can set any button to any function.  Valid button functions are:  Off,
Pick-off attempt, Foul, Ball, Strike-swinging, Strike-looking.  If you set a button to
off,  that button will default to its regular Palm function.

The No Pitch

ScorePAD allows you to record a No Pitch by touching the N button.  Fortu-
nately, this rarely occurs.  A no pitch happens when the pitcher attempts a pitch
and for some reason, either the batter asked for time-out, the umpire wasn't
ready, something or someone interfered, or for some other reason, the umpire
calls "No pitch," and throws his hands up and forward.  The pitch still adds to
the pitch count but isn't called a ball or a strike.

Foul

StrikePick Off Attempt

Ball
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Reaching base

When a batter gets a base on balls or a hit, touch the proper on-base button
on the left side of the atbat square.

q BB - Walk or base on balls
q 1B - Single
q 2B - Double
q 3B - Triple
q HR - Home run

For other on-base types, touch the On Base button at the bottom of the GSP
view and select the proper on-base result.

Refer to the Reference chapter in this manual for a list of on-base results and
their reasons.  Once you select an on-base result, all pitch buttons disappear
and a single Pitches button appears.  To view or edit pitch detail, touch the
Pitches button.

You can cancel an on-base result you have selected by touching the Undo
button.  This button does not undo the effects of a selection on other players
on base.  You will need to use the Prev button to get back to each batter and
undo any changes made.

Advancing base runners

When you select an on-base result, the On Base button disappears and the
Advance button appears.  After touching the Advance button, select the
proper advance reason from the list.  Advance reasons such as batter advance
will prompt you for more information.

Drag and drop base advances

While you record the atbat of current batter ( the batter now at the plate,)
you can use the Drag-and-Drop runner advance feature.

Drag-and-Drop base advances were design to allow you to advance runners on
base while recording the balls and strikes for the batter.  This saves you from
moving from one atbat to the next every time a runner advances.  Drag-and-
drop allows you to advance any runner presently on base from the screen of
the batter at the plate.  Drag-and-drop base advances will not work if the
current batter has reached base.
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To use Drag and drop, complete the following steps:

1. Touch your pen on any occupied base and drag from that base to the destina-
tion base for that runner.  The base will highlight when you've dragged far
enough.

2. Lift your pen.  ScorePAD will display a list box of Advance types.

3. Select the appropriate advance type.

Hold pen down and
Touch Runner drag to new base Select advance reason

You can also touch any occupied base to move to that atbat screen.

1. Once you are at the runner's atbat screen, touch the Advance button.

2. Select the appropriate advance type.

3.  ScorePAD will prompt you for the destination base for that runner.  Select
the destination base.

4. Once you have completed work on that atbat, touch Home plate and
ScorePAD will take you back to the current atbat.

Note: Drag-and-drop runner advances were designed as a convenience.
During an atbat, if a runner steals a base or advances on a wild pitch,
passed ball, etc., you can use drag-and-drop.

After you complete an atbat, you can no longer use drag-and-drop
base advances until you move to the next atbat, providing that atbat
hasn't resulted in the batter getting on-base or out.
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Recording an out

The GSP view allows you to record outs four ways.

q When you record pitches and record a total of three strikes, the  GSP
view assumes that the batter struck out.

q Whether a batter has reached base or not, you may touch the Out
button at the bottom of the GSP view and select an out result.  The
out result list also contains Strikeout so you can select Strikeout from
the list if you don't wish to touch strike three times.

q You can record outs using Graffiti abbreviations.  When using Graffiti
to record outs you write the an abbreviation of the out result.  For
example, writing "63" and the return gesture represents a grounder to
third thrown to first for the putout.  "F8 return" would be a
groundout to center field.

q When runners are on base, you may hold your pen on the runner for
two seconds.  When the list of out on-base reasons appears, select the
proper reason and record all defensive positions that assisted or
performed the putout.

Defensive Positions

Some outs will require that you enter the defensive positions that assisted in or
completed the put out.  The Defensive Positions dialog will appear when AtBat
needs that information.

Defensive Positions
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The Defensive Positions dialog shows the defensive positions by their position
names.  To record defensive positions, touch each position that assisted in or
completed the putout.  As you touch a defensive position button, the position
number for that position appears in the edit box on the bottom-left of this
dialog.  The Cancel Out button will appear until you enter defensive positions.
Once you enter defensive positions, the Cancel Out button will change to
Finish Fielders.  When you finish entering defensive positions, press Finish
Fielders.

If you make a mistake, touch the Undo button to erase that entry.  If you want
to cancel the out after you've entered one or more defensive positions, press
the Undo button until Cancel Out reappears.  Finally, press the Cancel Out
button.

Base running outs

If the current batter has not completed his atbat:

1. Hold your pen on the shaded base of the base until an out reasons list
appears.

2. Select the reason the runner got out.

You can also touch the base of the base runner or use the navigation buttons
described in this chapter to move to the atbat of a base runner.  You can then
press the Out button and select a base running out reason.

Switching sides

When you press the Next button, ScorePAD moves to the next logical batter
based on the game situation.  After three outs, ScorePAD will move to the first
logical batter on the opposing team.

In the case of maximum run rules or even the mutual agreement of the coaches
and umpires, teams may switch sides in situations where there are less than
three outs.  In these situations, use the Switch Sides menu command.  This
menu command causes ScorePAD to immediately move to the next logical
batter of the opposing team.
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Skip AtBat

ScorePAD allows you to skip a batter.  In games that use free substitution rules,
players might leave the game leaving nine or more players in the lineup.  Since
you can't reduce the size of the lineup once you've gone through the entire
lineup,  ScorePAD allows you to skip that player's atbat and score the next
batter.

In cases where the team has eight batters, the ninth batter would probably not
be skipped but counted as an out.  In these cases, don't use Skip AtBat.  Give
that batter an out.

Clear AtBat

With Clear AtBat you can erase all of the events of an atbat.  This command
quickly removes all pitches, base advances, reaches, outs, and hit location.

Advanced scoring - Graffiti abbreviations

Once you become an official expert baseball scorer (if you aren't already), you
can use ScorePAD abbreviations to score atbats.  You must use Graffiti to enter
these abbreviations.  ScorePAD recognizes abbreviations to speed up scoring
for those familiar with baseball.  Scoring this way feels nearly equal to scoring
with paper.  As you write the abbreviation with Graffiti, the letters you enter
will appear on the result line of the GSP view.  You must terminate your
abbreviation with the down forward slash ( the same stroke that you use to
begin a new line)  Below is a partial list of Graffiti abbreviations that ScorePAD
recognizes.

q 1B - Single
q 2B - Double
q 3B - Triple
q HR - Home Run
q BB - Walk or Base on Balls
q K - Strikeout - prompt for strikeout type
q Kc - Strikeout - last strike called
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q Ks - Strikeout - last strike swinging
q 63 - Groundout (short to first - or any other 1 assist infield out)
q T2 - Tag out by catcher (defensive position 2)
q L3 - Line out to first base (defensive position 3)
q F8 - Fly out to center field (defensive position 8)
q DP463 or 463 - Double Play

ScorePAD recognizes many more abbreviations.  This is just a partial list.  Check
the Reference chapter for an exhaustive list of abbreviations.

Navigation

The GSP view also allows you to move from one atbat to the next.  The Prev
and Next buttons are located on the left side of the GSP view just under the
pitch buttons.  The Prev button moves you backwards to the last batter.
ScorePAD records atbats in the order they occur.  As you move backward you
may move from one team to the next.

The Next button moves you forward to the next atbat.  ScorePAD observes
the number of outs and moves you to the correct team and batter.  This
happens only when you touch the Next button while at the current batter.  The
Next button disappears while the current batter is at the plate.  When you
enter a result, either out or on-base, the Next button reappears.  When you
reach the last out of the game, or the winning run is scored, the next button
will not reappear again.

You may also use the up and down Palm OS device hardware buttons to move
from one atbat to the next.  The top button moves you to the previous atbat
while the bottom button moves you to the next atbat.

Previous batter Next Batter

Instant Batter, Pitcher, and Inning Stats

You may wish to see player, game, or pitcher statistics while you score a game.
The GSP view provides access to three pop-up or instant sets of statistics.  For
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InstantSTATS you must touch and hold your pen on a predetermined area of
the screen.  When you touch that part of the screen the stats will appear.  They
will remain on the screen as long as your pen maintains contact with the
screen.  When you lift your pen from the screen, the InstantSTATS disappear.

You can see the batter's statistics by touching and holding your pen on the
player's name at the top of the GSP view.

Instant batter stats

You can see pitcher's statistics by touching and holding your pen on the pitch
line at the bottom right of the GSP view.

Instant pitcher stats

 You can see inning totals by touching and holding your pen on the score.  The
score line is the line just below the players name.
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Statistics

Batters

The Batter Stats dialog shows each batters offensive statistics during the
current game.  This dialog displays the number of atbats, runs, hits, RBI, walks,
strikeouts, stolen bases, and season batting average for each player in the lineup.
You may select either team by pressing the team selector at the top of this
dialog.

Batter Stats Dialog

Pitchers

The Pitchers dialog shows game statistics for each pitcher.  In the ScoreCard
view, pitchers of the displayed team appear on the Pitchers dialog.  Conversely,
in the GSP view, pitchers of the opposing team appear on the Pitchers dialog.
You may switch teams by pressing the team selector at the top of this dialog.

Pitchers Dialog
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Box Scores

The Box Scores dialog shows the number of runs scored in each inning by each
team.  Invoke the Box Score dialog by selecting Box Scores from the Stats
menu in the ScoreCard and GSP views. In the event the game lasts more than
nine innings, the Box Scores dialog will display the last nine innings of the game
at all times.

Instant Pitcher Stats

You can only access Instant Pitcher Stats  from the GSP view. Whenever you
touch the pitch count in the GSP view, Instant Pitcher Stats will display as long
as you hold down your pen.  When you lift your pen, the stats disappears.  The
pitcher stats pop-up displays the following:

q Innings pitched
q Batters faced
q Total pitches
q Balls & strikes
q Hits
q Runs/earned runs
q Walks/intentional
q Strikeouts
q Home runs
q Wild Pitches/Balks/Hit Batsmen
q Ahead in the count/Behind/Even Pitches
q Groundout/Flyout/Strikeout
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Instant Batter Stats

You can see instant batter statistics from the ScoreCard view and the GSP view.
In the GSP view you touch the batters name to show these pop-up stats.  In
the ScoreCard view you touch the players number.  As with the Instant Pitcher
Stats, these stats appear only as long as you hold your pen on the screen.

Instant Batter Stats displays the following batter statistics:

q Season and game offensive stats
batting average runs batted in
slugging percentage stolen bases
hits doubles, triples home runs
runs batted in

q Season and game defensive stats
assists errors
putouts passed balls
double plays

q Game walks and strikeouts

The Instant Batter Stats pop-up shows you previous atbat results as they
appear in the ScoreCard view.  The inning and the pitch count appear above and
below the atbat square respectively.

Instant Lineup with atbats and hits

For your convenience, on the GSP view, ScorePAD allows you to take a quick

Touch here
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look at the current lineup of the batting team. ScorePAD identifies the first
batter of the inning with a line just over that players name. This feature oper-
ates  like pop-up statistics.  To display the current batting order with atbat/hit
data on each batter, touch the inning and batter count in the lower left-hand
corner of the atbat square.  When you lift your pen, the pop-up will go away.

Pitch Charting

Pitch Details Dialog

To perform pitch charting in ScorePAD you must set the Pitch Detail prefer-
ence in the GSP view.

1. Select Preferences from the Options menu to bring up GSP view prefer-
ences.

2. Check Record Pitch Detail to start pitch charting.
You may also want to check Record Hit Type.  This allows you to record the
way the batter put the ball in play on a particular atbat.

If you want to record pitch location from behind the batter, you will want to
check Pitch Location From Behind.  Checking this allows a more natural
location recording sequence from behind the batter.  Press OK to exit the
Preferences dialog.

With pitch charting turned on, the Pitch Details dialog will pop up after you
record each pitch, on base, or out.  The Pitch Detail dialog contains the follow-
ing information:

q Pitch location chart
q Pitch types
q Swing types
q Pitch results
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q Pitch speed
q Atbat pitch count
q Current ball/strike count

You can also enter the Pitch Details dialog by selecting Edit Pitches from the
AtBat menu of the GSP view.

You can scroll to any pitch and change its detail during the course of an atbat.
This dialog will appear whenever you record anything that involves a pitch.

After each ball put in-play, a list of hit types will appear.  As soon as you pick a
hit type, the list goes away.

Effective pitch charting means you must show not only the type of pitch and
how that pitch was hit, but also where the pitch was hit.  To accomplish this you
simply touch the part of the field where the ball landed when you return to the
GSP view

You can record balls and strikes in the Pitch Detail dialog if you wish.  This
feature allows you to remain in the Pitch Detail dialog during an entire atbat. To
record balls, strikes, fouls, and pick-off attempts, you must use the Palm OS
hardware buttons.  See that chapter on Scoring an Atbat for details on the
hardware buttons.

To insert a pitch in the middle of a pitch sequence, touch the plus (+) button.
This allows you to insert a pitch anywhere in the sequence without having to
delete or change other pitches.  To remove a pitch, touch the minus (-) button.
The up and down scroll buttons allow you to move between pitches.

When a batter gets out or on-base any reason other than a strikeout or a walk,
you press either Out or On Base buttons.  Both of these buttons add an Inplay
pitch, which you can chart.  When you press the OK button, ScorePAD will
prompt you to enter the out or on-base type and defensive assists and put out
if necessary.

AtBat Detail dialog

Select Edit AtBat Details from the AtBat  menu of the GSP view.  In the
AtBat Detail dialog you can force RBI and earned or unearned runs.  You also
use the AtBat Detail dialog to identify pinch runners.
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Atbat detail dialog

Once you have scored an atbat you might need to go back and change some-
thing about it.  If it's balls and strikes, you can touch undo until you come to the
point at which the balls and strikes were correct.  At this point add the proper
pitch sequence and the result of the atbat.

 Sometimes, however, you need to change different information.  Perhaps you
missed the substitution of the pitcher or the batter.  You may have scored the
atbat for the wrong batter or even the wrong team.

The AtBat detail dialog allows you to change the team, player, pitcher, whether a
run was an RBI, and/or whether the run was earned or unearned.  Additionally,
ScorePAD makes logical determinations for RBI and earned runs.  To overrule
ScorePAD, you must use the Atbat Detail dialog.

Preferences dialog

Preferences Dialog
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The preferences dialog allows you to turn atbat recording of atbat information.
This dialog allows make that choice.

Pitchers play other positions

If you are scoring a game in which any defensive player may become the pitcher
at anytime, check this box.  ScorePAD will allow you to select any defensive
player as the pitcher in the AtBat Detail dialog.

Show batters season  average

This preference allows you to display the season average of each batter on the
GSP view.  ScorePAD recomputes each batter's season batting average after
each atbat and re-displays the new average.  Depending on the number of atbats
a player has, the average may or may not change.

International tie-breaker rule

This preference turns on ScorePAD's implementation of the softball Interna-
tional Tie-breaker Rule.  When a game goes into extra innings, ScorePAD will
automatically place the player on second base who had the last completed atbat
in the previous inning for the offensive team.  ScorePAD will do implement this
rule every half inning until the game ends.  You can turn this preference on or
off at any time.

Use short fielder position

This preference causes the Short Fielder position to appear in the Defensive
Positions dialog.  The Defensive Positions dialog appears after each out.  The
Short Fielder position is used in softball as a tenth defensive position.

Show previous atbats

This preference turns on the display of previous atbat squares for the Score-
Card view on the Game Situation Panel (GSP) or atbat view.  Up to 5 of the
previous atbats will display during the atbat.  When the atbat completes in an
out or on-base, the previous atbats will go away.  During the first atbat, season
batting average, home runs, and RBI will display.

ERA Innings

The preference allows you to select the number of innings the Earned Run
Average (ERA) calculation uses to compute a pitcher's ERA.  For MLB players
this number is always nine.  Use a number that indicates the average or fixed
length of games in your league.
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Pitch Detail Preferences

Record pitch detail

The Pitch Detail dialog will appear after you record each pitch.  This dialog
allows you to record pitch result, pitch type, pitch location, pitch speed, and
swing type.  If you don't want to record pitches at this level of detail, don't
check this box.

Record Hit Type

When selected, ScorePAD will present a list box for each ball put in play.  This
list box will allow you to pick the hit type.  Hit types are  Fly, Line, Grounder,
Popup, Bunt, and Blooper.  Once you pick a hit type, ScorePAD proceeds as
usual.

Pitch location from behind

If you've checked Record Pitch Detail, and your point of view is behind the
batter, this selection allows charting the pitch location from that point of view.

Pitch count only balls & strikes

Check this box if you want all pitch counts to include only balls and strikes.
Normally, ScorePAD computes the pitch count using the sum of balls, strikes,
pick-off attempts, and no-pitches.
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Button Preferences dialog

Button Preferences dialog

The button preferences dialog allows change the default behavior of Palm OS
hardware buttons.  The four buttons at the bottom of your Palm OS device are
normally used to switch to Datebook, Phonebook, ToDo, or Memo native
applications.  In the GSP view, by default they are set to record the following
pitch types:

Datebook button Pick-off attempt (POA)
Phonebook button Foul
ToDo button Ball
Memo button Swing strike

You can use this dialog to change the behavior of these buttons.  Any button
may be set to any of the following behaviors:

1. Off
2. Pickoff attempt
3. Foul
4. Looking strike
5. Swinging strike

If you set a button to "off", it assumes its default behavior and switches you to
the appropriate application.  Otherwise, each hardware button will record
defined pitches while a batter is at the plate.  After the batter reach base or is
out, the button are disabled.  They can't be used to switch to other applications
or record additional pitches once an atbat is complete.  Once you leave the
GSP view, the Palm OS hardware buttons revert to their normal behavior.
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Ending a game
After you've scored an entire game, you may want to keep a permanent record
of that score card.  ScorePAD makes a permanent record the same way as
other Palm OS applications by performing a HotSync operation.  If you aren't
familiar with this process, The Palm OS Handbook explains the HotSync
process in detail.

Before you HotSync, ScorePAD contains three utilities that you might want to
execute.  ScorePAD allows you to do the following with a completed game:

q Save starting lineups
q Set the status of the game as complete
q Set the winning, losing pitchers
q Set the save pitcher if necessary
q Add game stats to RosterPAD stats

Saving starting lineup

To save the starting lineup select Save Lineup from the Options menu of the
ScoreCard view.  ScorePAD will give you the opportunity to save the starting
lineups of either or both teams.

Once you make your selection, ScorePAD instantly saves the lineup(s).  Score-
PAD saves the batting order and position of the starters even if you have
substituted other players for the starters.  ScorePAD will create RosterPAD
entries for each player created in the Lineup view if they don't already exist.
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Setting the game status to 'Complete'

To signal ScorePAD that you've completed a game, you must set the ending
time of the game. If the game goes through the number of scheduled innings
you specified in the Game Parameters dialog, ScorePAD will prompt you to set
the ending time to the time when the game ending play occurs.  If you answer
'No' to that prompt or the game ends before the end of its scheduled end
inning, select Game Setup from the Options menu of the ScoreCard view.

Touch the field next to End Time and ScorePAD will present you with a time
selection dialog.  The dialog will automatically set the end time as 3 hours past
the begin time.  If the game has just ended, touch the Now button to enter the
current time. If you would like to set the time, touch the hours or minutes and
use the up and down arrows to change them.  Select the am or pm as appropri-
ate.

Once you set an ending time for a game, the game is closed.  ScorePAD will not
allow you to add any more atbats.  You can change details about existing atbats,
game parameters, and lineup information.

If you want to reopen the game to change atbats or add new atbat, set the End
Time field of the Game Setup view to In Progress.

Setting the Winning, Losing, and Save pitchers

Select Win/Lose Pitcher from the Stats menu of the Scorecard view.

Only the pitchers of the winning team will appear in the Winning Pitcher list.
Likewise, the pitchers for the losing team will appear in the Losing Pitchers list.
Pitchers from the winning team will also appear in the Save Awarded list.
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Select the winning, losing, and save pitchers as determined by the official scorer..
Only select a save pitcher if the official scorer awards a save.

Marking save opportunity pitchers

Relief pitchers that entered the game under a save opportunity situation should
be credited with a save opportunity.  If the pitcher actually gets the save, you
will have marked the pitcher as the Save Pitcher.  ScorePAD automatically
credits a Save Pitcher with a save opportunity.  If however, a relief pitcher
enters the game in a save opportunity situation but doesn't get the save, for
whatever reason, you should credit that relief pitcher with a save opportunity.

To credit a pitcher with a save opportunity:

1. Select Edit Lineup from the Options menu of the ScoreCard view
2. Touch the player number of the pitcher
3. Select Edit player detail from the Player menu
4. When the player detail dialog appears with the pitcher's name, check

the Save opportunity checkbox

Updating statistics

ScorePAD generates offensive and defensive statistics for each player that
participates in a game.  ScorePAD also generates pitching stats for each pitcher
that participated in the game.

To add these statistics to the totals maintained by RosterPAD, select Update
Stats from the Stats menu of the ScoreCard view.  ScorePAD will take several
seconds to calculate and transfer the batter and pitcher statistics to RosterPAD.
ScorePAD will be ready to begin the next game using the updated stats.
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Using infrared with ScorePAD
You can transfer or beam lineups and games between infrared equipped Palm
OS devices.  This allows you to share games with other Palm OS users.  For
instance, if you arrive late at an ongoing game, you might ask another ScorePAD
user to transfer his score sheet of the game to your device after the current
atbat.

Beaming represents a breakthrough in sharing scoring information.  A full game
with 9 innings of play including substitutions, batter stats, pitcher stats spray
charts, box scores, umpires, and dates and times can be beamed from one Palm
OS device to another in 10 seconds.

As ScorePAD becomes prevalent among team scorers, you will see coaches
meeting at home plate with Palm OS devices and trading lineups via infrared.

Beaming games

To beam a game from one Palm OS device to another you must lineup the
infrared ports of the devices

On the sending device;

1. Open the ScorePAD game you wish to transfer
2. Select Beam Game from the Options menu of the Score Card view

On the receiving device:

1. You will be prompted to accept or reject the incoming game with the
standard Palm OS Beam dialog.  If you already have a copy of the game being
beamed to your device, ScorePAD will prompt as to whether or not you want
to replace the game already in ScorePAD with the incoming game, create a new
copy of the game, or reject the game being beamed to you.
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2. Once you accept the game, ScorePAD will open that game in the Score Card
view.  You may now HotSync the game to your desktop.

ScorePAD remembers everything about the game you have received.  For
instance, if the game is still in progress you can touch the Batter button and
ScorePAD will take you to the Atbat of the next logical batter.

Beaming lineups

Beaming lineups works slightly different than beaming a game.  The purpose of
beaming lineups is for two scorers of opposing teams to exchange lineups.  For
that reason ScorePAD assumes that you have already created a game into which
you want a beamed lineup to go or from which you want to beam a lineup to
another scorer.  If you want to receive both lineups from another scorer, have
that scorer beam his entire game to you.

To beam a lineup you must lineup the infrared ports of the Palm OS devices
and,

On the sending device:

1. Open the ScorePAD game containing the lineup you want to beam
2. Select the team whose lineup you want to beam
3. In the Score Card view, select Beam Lineup from the Options menu
4. ScorePAD will immediately beam the lineup of the selected team via the
infrared port.

On the receiving device:

After receiving the beam lineup, ScorePAD prompts you as to whether or not
you wish to receive the lineup into the current game, pick another game, or
reject the lineup:
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Beamed lineup receive dialog

If you choose to receive the lineup into the current game, ScorePAD will find
the team of the current game that matches the team of the beamed lineup.
ScorePAD will then set the lineup for that team to the beamed lineup.
If you choose to pick the game into which the received lineup will go, Score-
PAD will allow you to pick the game and team using the following dialog:

Beam lineup pick game dialog

To pick the game and team:

1. Select the Home or Visitors (ScorePAD will default to whichever the
sender set the team)

2. Select game to which ScorePAD will set the lineup
3. Touch the Receive button to receive the lineup or touch the Reject

button to reject the lineup.

Once you've accepted the beamed lineup, ScorePAD will restart and open the
game to which you sent the lineup.  After receiving a lineup or a game, Score-
PAD treats that game or lineup as if it had originated on your device. You need
not treat beamed games or lineups any differently than lineups or games that
you created on your Palm device.
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Reference

Atbat result types

Reach Base Types
x = defensive position 1-9

Score Card Graffiti
Display Abbrev

Base On Balls BB BB
Single 1B 1B
Double 2B 2B
Triple 3B 3B
Home Run HR HR
Hit Batsman HB HB
Fielders Choice FC FC
Error E E or Ex
Sacrifice SAC SF or SB
Dropped 3rd Strike Kd3 Kd3
Defensive Interference DI DI
Obstruction OB OB
Sacrifice Fielder's Choice FC FC
Sacrifice Error E
Didn't See ??
Tie-breaker TB TB

Out Types - Batter
x = defensive positions 1-9

Score Card Graffiti
Display Abbrev

Strike Out Kc or Ks K, KC, or KS
Ground Out xx (e.g. 63)
Tag Out Tx T or Tx
Line Out Lx L or Lx
Fly Out Fx F or Fx
Pop Out Px P or Px
Foul Out fFx FF or FFx
Double Play DP DP or xxx
Triple Play TP TP or TPxxx
Infield Fly Rule IF IF or IFx
Sacrifice Fly SF SF or SFx
Sacrifice Bunt SB SB
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Bunt Foul 3rd Strike Kb KBF
Spectator Interference Is IS
Offensive Interference Io IO
Illegal Bat IB
Out of Batter's Box OBB OBB
Basepath Violation BV BPV
Didn't  see ??

Out Types - Runner

Force
Thrown Out
Tagged Out
Picked Off
Caught Steal
Auto Appeal
Voice Appeal
Refused Score
Reverse Base
Basepath Violation
Passed Runner
Offensive Interference
Didn't See

Advance Runner

Batter
rror
Throw
Fielder's Choice
Steal
Indifference
Wild Pitch
Passed Ball
Balk
Steal/Error
Defensive Interference
Defensive Obstruction
Umpire Interference
Runner Hit
Didn't See
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Pitch Detail

Pitch Types

Fast Ball
Slider
Split Finger
Curve
Knuckle Ball
Screw Ball

Swing Types

No Swing
Full
Half
Check
Bunt
Hit & Run

Pitch Results

Ball
Strike
Foul
Pick Off Attempt
No Pitch

Pitch Speed Range

16 MPH - 110 MPH

Current MLB Team
Abbreviations

American League

BAL Baltimore Orioles
BOS Boston Red Sox
CAL Anaheim Angels
CLE Cleveland Indians
CWS Chicago White Sox
DET Detroit Tigers
KC Kansas City Royals
MIN Minnesota Twins
NYY New York Yankees
OAK Oakland Athletics
SEA Seattle Mariners
TAM Tampa Bay Devil Rays
TEX Texas Rangers
TOR Toronto Blue Jays

National League

ARI Arizona Diamondbacks
ATL Atlanta Braves
CHI Chicago Cubs
CIN Cincinnati Reds
COL Colorado Rockies
FLA Florida Marlins
HOU Houston Astros
LA Los Angeles Dodgers
MIL Milwakee Brewers
MON Montreal Expos
NYM New York Mets
PHI Philadelphia Phillies
PIT Pittsburg Pirates
SD San Diego Padres
SF San Fransico Giants
STL Saint Louis Cardinals
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RosterPAD
RosterPAD enables you to keep team, name, number, position
offensive statistics, and other information about baseball players.

With RosterPAD you can:

q Quickly lookup or enter player information
q Accumulate and store  season offensive and defensive statistics
q Accumulate and store  pitcher  statistics
q Display calculated season statistics
q Assign players to leagues and teams
q Sort players by team or by name
q Create and edit team leagues

To open RosterPAD:

1. Touch the  icon in the Graffiti area to open the Applications Launcher..

2. Touch  the  icon  to open RosterPAD..
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Getting Started With RosterPAD Players

A RosterPAD player entry stores player information. RosterPAD makes creating
and editing player information simple.

Creating a RosterPAD Player

You can create RosterPAD players on your Palm device, or you can use the
ScorePAD desktop software to create RosterPAD players and download the
new players to your Palm device with the next HotSync operation.

To create a new RosterPAD player:

1. Start RosterPAD

2. Touch the New button to create the new player and display the Player Edit
screen

Touch New

3. Enter the last name of the player you want to add to RosterPAD.

4. Use the Next Field Graffiti stroke to move to the First Name field.

5. Enter the first name of the player.

6. Use the Next Field Graffiti stroke to move to the Team field.  For Major
League Baseball teams, you must enter a two of three letter team abbreviation.
For example, for the Cincinnati Reds you would enter CIN.  Check the Refer-
ence chapter in this manual for a full list of Major League Baseball teams and
abbreviations.
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7. Touch the Position field.  RosterPAD will display a list of recognized baseball
defensive positions.  Touch one of the positions in the list or <None> at the
top of the list.

8. Touch the Number field.  Use Graffiti to enter the player's jersey number.

9. Touch the Bat Order field. Pick from the list of batting order numbers.
ScorePAD uses this number to assign starting lineup slots.  ScorePAD updates
this number whenever you use the Save Lineup utility.

10. Touch the Bats field.  Pick from the list of batting hands; select Left, Right, or
Switch.  ScorePAD uses data in this field to set the batting hand in its GSP view.
If a player is a switch hitter, his batting hand is set opposite of the pitching hand
of the pitcher on each atbat.

11. Touch the Throws field.  Pick from the list of throwing hands; select Left or
Right.

12. The remainder of the fields are text fields.  You may enter data in those fields
if you like.  The data in the remaining fields are not used by ScorePAD.

Entering Batting Statistics

Touch the Batter Stats button

Touch Batter Stats

Once in the Batter Stats dialog, touch the desired field, then enter the statistic
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for that field using Graffiti.  If you use MLBStats, it will fill in all of the data on
this dialog whenever you update.  Additionally, ScorePAD updates statistics on
this dialog whenever you selection Update Season Stats from its Stats menu

Touch the Done button when you've entered all statistics.  If you wish not to
keep the statistics you've entered or changed, touch the Cancel button.

Editing a RosterPAD Player

After you create a RosterPAD player, you can update or add information to it at
any time.

To edit a RosterPAD entry:

1. Touch the RosterPAD entry that you want to change.  This will display the
Player View screen for that entry.

2. Touch the Edit button (or anywhere on the screen) to display the Player Edit
screen.

3. Touch any text field (Last name, First name, Team, Number) and enter or
change the information; or touch a selectable field (Position, Bat Order, etc.)
and make a new selection.

4. After you finish, touch the Done button to return to the Player List screen.

Deleting a RosterPAD Entry

There are two ways to delete a player: Use the Menu Commands (described in
the "Record Menu" section of this chapter, or use the Delete button on the
Player Edit view.
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To delete a player in the Player Edit view:

1. Touch the Delete button.  RosterPAD will display the Delete Player Alert

2. Touch the OK button to confirm that you want to delete the player.

Working with RosterPAD Players

RosterPAD allows you to find Players, group them by leagues, and display
players by name or team.

Looking Up Players

When working with RosterPAD, the scroll buttons on the front panel of your
Palm OS device make it easy to navigate among player entries.  In the Player List
view the scroll buttons move up or down an entire screen of players.

You can also use the Player List Look Up feature to quickly scroll to any player.

To look up a RosterPAD player:

1. Display the Player List view.

2. Enter the first letter(s) of the last name of the player you want to find.  As
you enter the letters RosterPAD will come closer and closer to selecting the
name you want.  If the players are sorted by team, enter the team abbreviation
to scroll to that team.

Lookup Line

3. Touch any player to view his record, or use the carriage return stroke to view
the selected player.
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Sorting by Player Name or Team

You can sort players in RosterPAD by Team and Last Name, or by Last Name
and First Name.  These settings do not change your RosterPAD data; they offer
you a different view of the data.

To sort players in the Player List view:

1. Display the Player List view

2. Touch the  icon to open the RosterPAD menus.

3. Touch Preferences... from the Options menu to the RosterPAD Prefer-
ences dialog.

Preferences Dialog

4. Touch the Team, Last Name setting to sort by Team and Last Name.

5. Touch the OK button to display the Player List view with all player names
sorted by Team.
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Beaming RosterPAD Players

Beaming allows you to transfer players and their statistics from on Palm device
to another via their infrared ports.  You can beam  RosterPAD players, teams,
and leagues.  Beamed players will not replace players you already have in
RosterPAD.  You may end up with duplicate players if you receive multiple
transfers of the same league, player, or team.

To perform any beaming operation, you must lineup the infrared ports of the
sending and receiving palm devices.  The infrared port is located a the top of
Palm III, Palm V and upgraded PalmPilot devices.

To beam a player you must:

1. Select a player from the Player List view.
2. Select Beam Player from the Record menu of the Player View. You may

also select Beam Player from the Record menu of the Player Edit view.

To beam a team you must:

1. Select a player from the Player List view that belongs to the team you wish
to beam.

2. Select Beam Team from the Record menu.  You may also select Beam
Team from the Record menus of Player View and Player Edit.

To beam a league you must:

1. Select the league you wish to beam from the Category List while in the
Player List view.

2. Select Beam League from the Record menu.  You may also select Beam
League from the Record menus of Player View and Player Edit.
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RosterPAD Menu Commands

RosterPAD includes menu commands to make routine file and editing com-
mands quick and easy.  This sections details RosterPAD menu commands.

Record Menu

When you select the Record menu, its commands appear on the screen.

Delete Record... Opens an alert dialog prompting you to confirm
deletion of the current entry.  Touch the OK button
to delete the current player from RosterPAD, or
touch Cancel to close the alert dialog and keep the
entry.

Attach Note Opens the RosterPAD Note dialog where you can
create a Note for the current player.

Delete Note... Opens an alert dialog prompting you to confirm
deletion of the Note attached to the current player.
Touch the OK button to delete the Note,  or touch
the Cancel button to close the alert dialog and
keep the note.

Zero Player Stats Sets all player offensive and defensive statistics to
zero

Zero Pitcher Stats Sets all pitcher statistics to zero.

Beam League Beams the current league using infrared

Beam Team Beams the current team using infrared

Beam Player Beams the current player using infrared
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Options Menu

When you select the Options menu, its commands appear on the screen.

Preferences Opens the Preferences dialog.

Select Last Name, First Name to sort players by
last name then first name.  Select Team, Last
Name to sort players by team then last name.
Touch OK to execute sort or Cancel to abandon
sort.  Both buttons close the dialog.  If you choose
to sort records, depending on the number of players
you have in RosterPAD, the sort can take several
seconds.

When checked, the Backup RosterPAD database
checkbox causes the HotSync process to backup the
RosterPAD database whenever you change it.  If your
HotSync process takes to long, uncheck this box.
Make sure you backup the RosterPAD database
periodically.

About RosterPAD Show version information for the RosterPAD
application
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MLBStats
MLBStats enables you to keep statistics up-to-date for any or all Major
League Baseball teams.  The website www.mlbstats.com is updated
everyday of the Major League Baseball season to make all player stats
available at a touch of your finger.

With MLBStats, you can use your Palm device and a standard Internet
connection to automatically update the statistics of any set of Major
League Baseball teams you select.

To use MLBStats you must have a Palm Modem or establish an Internet
connection through a serial TCP/IP connection from a Window NT
Workstation or Server.

MLBStats will:

q Connect to the Internet
q Allow you to select teams you want to update
q Update all players' statistics on the teams you select

Before starting MLBStats, you must use Palm Network Preferences to
setup your Internet service.  MLBStats immediately connects to the
Internet service that you setup and select in Network Preferences.
Check the Palm Handbook for detail on how to setup an Internet service.

To open MLB Stats:

1 Touch the  icon in the Graffiti area to open the Application
Launcher.

2. Touch the  icon to open MLBStats.
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Updating Player Statistics

After starting MLBStats, unless you've used the Network Preferences dialog to
connect to the Internet and currently have an active connection, MLBStats will
establish an Internet connection using your Palm Modem.  MLBStats will then
present the MLBStats main view.

MLBStats Main View

When  you successfully connect to the Internet, the Status will read Con-
nected.  If, for some reason, you  didn't connect successfully, the Status will
read Not Connected.

Adding teams to the list to update

To select the teams you want to update:

1. Touch the a team in the Teams list.

2. Touch the  button to add the team to the Selected Teams list

3. Repeat steps 1 & 2 until you've selected all teams you want to update.

4. Touch the Begin update button to start team updates.

MLBStats will update its status as its connects, and then updates each team.
After MLBStats completes it update cycle, the batter stats for each player will
contain updated statistics.
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To select all Major League Baseball teams:

1. Touch the  to add all teams to the Selected teams list

2. Touch the Begin update button to start team updates.

After updating is completed, the Status line will show All teams updated.
When you exit MLBStats, it will automatically terminate its Internet connection
if MLBStats made the connection.  If the connection was established outside of
MLBStats, upon exit, MLBStats will leave the Internet connection intact.

Removing teams from the list to update

To deselect the teams you don't want to update:

1. Touch the team in the Selected teams list.

2. Touch the   button to remove the team from the Selected Teams list

3. Repeat steps 1 & 2 until you have removed all of the teams you don't to
update.

Use the   button to deselect all teams.

 MLBStats subscription

MLBStats is offered on a subscription basis.  In order to gain the benefits of
MLBStats you must subscribe to this service each season.  MLBStats gives you
access to player offensive and defensive statistics everyday of the season by
10:00 A.M. Eastern US time.

Once you subscribe, you can download stats with the MLBStats application as
many times as you wish during the season.  You may also take advantage of
MLBStats download when they become available in Major League baseball
parks.

Look for details on MLBStats on the www.scorepad.com and
www.mlbstats.com websites.
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ScorePAD Desktop
ScorePAD Desktop is a Windows-based baseball game and player statistics
viewing and reporting system.  ScorePAD Desktop also allows you  to create
and edit leagues and team rosters.  After you score baseball games on your
Palm device and synchronize with your desktop, ScorePAD Desktop gives you
access to those games.

With ScorePAD Desktop you can:

q View score cards of games scored on your Palm device
q Print detailed score cards of games scored
q Print a statistical summary for each team of each game
q View and print compiled statistics from games scored
q View and print year-to-date statistic from RosterPAD
q Create, edit, and print team rosters
q Update statistics over the Internet with MLBStats (optional software)

ScorePAD Desktop acts as an archival place for the games you score on your
Palm device.  Palm devices are the perfect platform for scoring baseball games
because of their size and input style.  ScorePAD Desktop overcomes the
limitations of viewing area and storage capacity on Palm devices giving you the
best of both worlds.   ScorePAD Desktop makes use of the relatively unlimited
space and substantial viewing area of desktop computers for viewing and
reporting on games scored on the Palm.

ScorePAD Desktop takes advantage of the Desktop computer power allowing
you to analyze games, player statistics, and hitting charts.

ScorePAD Desktop is divided into four major views:

ScoreCard view Displays games scored with ScorePAD Palm
Exports game statistics to a text file
Prints graphic scoresheets
Prints detailed game reports
Displays complete lineup information
Edits game parameters

Roster view Allows entry and editing of team rosters and statistics
Prints team rosters
Allows entry and editing of leagues
Allows updating of MLB player statistics (for MLBStats
subscribers)
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Stats view Displays statistics compiled from games scored
Displays year-to-date statistics from RosterPAD
Allows selection of statistics displayed and printed
Allows sorting of statistics by any category
Prints statistics from each subview

Spray chart view Displays balls put in play by hitters
Allows selection of hitters and pitchers
Prints spray charts

ScoreCard view

Roster view
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Stats view

Spray chart view
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ScoreCard View

After scoring a baseball game with ScorePAD on your palm device and synchro-
nizing with your desktop, you can view the game in the Score Card view.  This
view displays both visitor and home team score cards on one screen in a
compressed format.  You can click on any atbat to see its detail.  The atbat detail
window shows everything you would want to know about that atbat.  You can
also print both score cards from the Score Card view.

The Score Card view does not allow you to make any changes to game data.  All
game data synchronized to the desktop contributes to the season statistics of
all players stored in the roster database.

Loading a game

ScorePAD Desktop uses a different tool bar for each view.  In the Score Card
view, the toolbar allows you to select the team match-up and the date of the
game.

First select the team match-up.  For example CIN at ATL  would represent the
Cincinnati Reds playing the Atlanta Braves in Atlanta. If the ScorePAD Desktop
contains only one game with the team match-up you selected, ScorePAD will
automatically load that game.

If you have more than one game of  CIN at ATL, the Dates combo box will
contain all of the dates and times of those games.  Once you select the proper
date and time of the game, the ScorePAD Desktop will load and display the
specific game you selected in the Score Card view.
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The Score Card

Sample ScorePAD Desktop Score Card

The Score Card view displays both of the score cards of each game.  Each score
card displays the following information:

q Team name and score in game
q Player information
q Results of all atbats for the team
q Detail of a specific atbat

The Score Card view displays the team name and score at  the top of the score
card.   The player information section of the score card occupy the first  four
columns of the score card.  Player information columns contain:

q Player number
q Player name
q Player defensive position
q Inning player left the game (if applicable)

The atbat results grid displays atbat results.  The grid uses the same nomencla-
ture and graphic representation as ScorePAD for Palm devices.  The grid
displays base advances, and runs scored in different colors.
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Looking at an atbat's detail

You may want to examine in detail a particular atbat.  To do this, you click on
any atbat square in a score card.  The detail of that atbat will instantly display to
the right of the score card to which it belongs.

The Atbat Detail square contains:

q Player name & number
q Pitcher name
q Inning and atbat number during inning
q Atbat result
q Inning out number
q Positions involved in putout
q Out on-base and reason
q Base advances and reasons
q Pitch sequence
q Final ball & strike count

You can select and examine any atbat you want on either score card.  When
you print the score sheets, information in the Atbat Detail square will be
printed for each atbat except player name and number, pitcher name and
number, and pitch sequence.

Printing the score sheets

To print the score sheets of a game you've loaded in the Score Card view,
select File Print... from the menu.

When the Print dialog appears the Pages fields in the Print Range section
from: and to: default to 1 and 2 respectively.  The visitor score card is page 1
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Sample Printed Score Sheet



81

and the home score card is page 2.

o If you want to print both score cards, use the default.
o If you want to print only the home team, change the from: field's value to

2 so that both the from: and to: fields of Pages have a value of 2.
o If you want to print only the visitor score card, change the to: field's value

to 1 so that both the from: and to: fields of Pages have a value of 1.

You can preview before printing score sheets.   Select Print Preview from the
File menu to preview the output of  score sheets.  Print preview allows you to
look at both pages at once or one at a time before you print them.   You can
zoom in and out if you want to see more detail.

Printed score sheet detail

Printed score sheets have the same general structure of  the score sheets
displayed in the Score Card view, however, printed score sheet contain the
atbat detail in each of the atbat squares.  The printed score sheet also contains
the following:

o Player stats
o Inning stats
o Pitcher stats
o Game logistics

Exporting game statistics

ScorePAD Desktop allows you to export the game statistics to a spreadsheet
compatible file format.   This will allow you to use game statistics generated by
ScorePAD with other baseball statistics programs or spreadsheets.  The format
of this game statistics file is in the Reference chapter at the end if this manual.
You can export any loaded game by selecting File Export game statistics.
ScorePAD generates a file name that contains both teams and the date of the
game (ex: ATL_AT_CIN_08_04_1999.asg.)

Editing game parameters

You view and edit game parameters in the ScoreCard view.  Select Game
Parameters from the Edit menu to show the Game Parameters dialog.
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This dialog allows you to change the following game parameters for each team:

League - The team's league
Players - The number of lineup players
Standing - The numeric standing of the team within its conference or league.
Teams can be placed from 1st to 30th.
Games from 1st - The number of games out of first place.  Enter any number
of games from first.
Scheduled Innings - The number of innings for which the game was sched-
uled

You can also select the following parameters for the game:

Game Type - The time, relative to the season this game was played.  Valid
Game Types are: Season, Pre-season, Division series, League championship,
World championship, District tournament, Sub-state tournament, State tourna-
ment, Regional tournament, National tournament, Exhibition, & Scrimmage
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Series number - A unique series number that allows ScorePAD to categorize
statistics by series.

Viewing lineup players

To view the lineup players for either team, double-click any lineup player on the
ScoreCard view.  After you double-click, the Lineup Players dialog will appear
with the lineup information for all players of that team.

The Lineup Players dialog displays the following information about each player
in the lineup:

Order - Batting order number
# - Uniform number
Last - Last name
First - First name
Pos - Defensive position
Start - Inning player entered the game
End - Inning player left the game
End Btr - If player left the game while team was on defense, the number of the
complete batters in the inning when the player left the game

Deleting a game

You can delete any game in ScorePAD by loading the game and selecting. File
Delete Game.  Once you delete a game, you cannot not recover that game.
Before you respond to the confirmation prompt, be sure that you want to
delete the game that you have loaded.



84 ScorePAD Handbook

Examining pitching sequences

The ScoreCard view allows you to examine and print pitch charts.  If you chart
pitches during games you score, you can examine and print those charts in the
ScoreCard view.

The "Home team pitch sequence" and "Visitor team pitch sequence" tabs allow
you to display and print the pitch sequences of each atbat in the subviews.

The first square of the sequence shows the match-up.  It includes the following
information:

q Batter's name and number
q Inning and batter in inning
q Batter's batting hand
q Pitcher's name and number
q Pitcher's throwing hand

The pitch sequence charts display the following for each pitch:

q Pitch location
q Pitch type
q Count before pitch
q Pitch result
q Swing type

The final square is a graphic of the atbat square from the scoresheet.

Pitch chart example

To access the pitching charts for a game, load the game and select either the
"Home team pitch sequence" tab or the "Visitor team pitch sequence" tab in
the upper right-hand corner of the ScoreCard view.

For details on how to record pitch detail, read the "Pitch Charting" section of
the chapter "Scoring an atbat" in this manual.
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Moving to other views

You can select other ScorePAD Desktop views from the view menu.  Select any
of the following menu items from the View menu to move to other views:

Roster moves you to the Roster view.
Team Stats moves you to the Stats view.
Spray chart moves you to the Spray chart view.
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RosterPAD Desktop
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RosterPAD View

The RosterPAD view provides desktop maintenance of  the ScorePAD's team
roster database.  The RosterPAD view is the desktop companion of the
RosterPAD for Palm OS.  If RosterPAD looks familiar, it should.  RosterPAD
was designed to look and work like the address book in the Palm Desktop.  This
design decision allows you to remain in familiar territory and hopefully provide
a lower learning curve for using the RosterPAD view.

In the RosterPAD view you can:

q Add new players
q Edit existing players and their statistics
q Delete players and their statistics
q Cut, copy, and paste players using the Windows clipboard
q Import players and statistics from text files
q Export players and statistics to text files
q Create, edit and delete RosterPAD leagues
q Move players between RosterPAD leagues
q Update Major League Baseball rosters and player statistics

RosterPAD allows up to 15 leagues.  To move to the RosterPAD view, select
Roster from the View menu.

Adding players

To add players:

1. Click the New button in the RosterPAD view.

2. Type first name last name, team, player number in the appropriate boxes.

3. Select proper position, batting and throwing hands

4. If this player routinely starts games, select the batting order in which he
will normally appear.

5. Click the OK button when you have finished editing the record.
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You can also add address information and notes:

To add address information:

1. Click on the Address Tab

2. Add address, city, state and zip, and phone

To add notes:

1. Click on the Note Tab

2. Type in any free form note

Player statistics:

1. Click on the Stats Tab

2. Enter player season-to-date offensive and defensive stats

Changing player info

Double-click the record in the player list or click on the desired player in the
player list and click the Edit button.

From the Player Tab:

Edit information in the Last Name, First Name, and Team boxes.

Click the Position, Batting Hand, Batting Order, or Throwing Hand boxes and
select new values.

Click the League box and assign the player to a league.

From the Address tab:

Change address information in the appropriate boxes.

From the Note tab:

Type any additional information in the form of free-form text.
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From the Player Stats tab:

Change player offensive and defensive season-to-date statistics

From the Pitcher Stats tab:

Change Atbats, Hits, RBI, Home Runs, and Stolen Bases statistics.

Sorting players

1. Click the List By... button in the RosterPAD view.

2. Select Last Name, First Name to sort players by player name or, select Team,
Last Name to sort players by team.

3. Click the OK button to close the dialog and initiate the sort

4. Click the Cancel button to leave the record sorted in the current order.

Deleting players

Select the players you want to delete:

1. Click on one player or,

2. Click on the starting player, hold down the shift key and click on the last
player or,

3. Hold down the control key and click on each player you wish to delete.

Press the Del key.

Answer yes to the Delete Confirmation dialog.

Moving players among leagues

You can move one or more players to from one league to another.  To move
players to another league you must:

1. Select the players you want to move
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2. Select Change League from the Edit menu.

3. Select the new league from the Change League dialog

Printing players

Select Print from the File menu to print all of the player records or the
selected records in their current sort order.

Exporting and importing players

You can export players from the Roster database and import players into the
Roster database.  Of course, any players you add to the database will be
automatically transferred to your Palm computer during the next HotSync
operation.

To export players from the RosterPAD view:

1. Select the players you wish to export in the Roster view player list.

2. Select Export players from the File menu.

3. An Open dialog will appear with the default file name of SPPlayers.SPP

4. Enter an new file name, if you desire.

5. Press the Open button to export the selected players

To import players into the RosterPAD view:

1. Select Import players from the File menu.

2. Enter a file name or press the Browse button and select a file.

3. RosterPAD will import the files.

RosterPAD's import utility requires that fields be in the order specified in the
File Formats chapter of this manual.  You do not have to include all RosterPAD
fields, however Last Name, First Name, League, Team, and Player Number are
required.
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Using the clipboard with the RosterPAD view

You can cut, copy, and paste RosterPAD records using the Windows clipboard.
This allows you to quickly move player information and year-to-date statistics
from ScorePAD to other applications like spreadsheets, word processors, and
databases management system.  You can also use cut and paste to move players
from one league to another.

To cut players from the RosterPAD view:

1. Select the players you want to cut.

2. Select Cut from the Edit menu or press Ctrl-X.

3. The deleted players and their statistics are now in the Windows clipboard.

You can now paste them back into the RosterPAD view or into other applica-
tions.

To copy players in the RosterPAD view:

1. Select the players you want to copy

2. Select Copy from the Edit menu or press Ctrl-C

The selected players and their statistics are now in the Windows clipboard.  You
can now paste them into other leagues in the RosterPAD view or into other
applications.

To paste players into the RosterPAD view:

1. Copy players to the Windows clipboard.  You copy from the RosterPAD
view of ScorePAD or another application.  If you copy from another
application, you must arrange fields in the order specified in the File
Formats chapter of this manual.  You do not have to include all RosterPAD
fields, however Last Name, First Name, League, Team, and Player Number
are required.

2. Select Paste from the Edit menu or press Ctrl-P.

You can also select all of the player in the current league.  Select Select All
from the Edit menu or press Ctrl-A.
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ScorePAD's Stats View
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Stats View

The Stats view of ScorePAD offers a statistical summary of player performance
by compiling the statistics of all games contained in ScorePAD Desktop's
database.   This view can also display  year-to-date statistics from RosterPAD
data.

With the Stats View you can:

q Display offensive and defensive season stats for each player
q Display day-by-day offensive and defensive statistics for each player
q Display season pitching statistics for each pitcher
q Display day-by-day player and team pitching statistics
q Display day-by-day home runs made and given up
q Print stats sheets
q Export statistics to text files
q Create web pages from statistics subviews
q Configure subview statistics content and order
q Update RosterPAD season statistics from games scored

The Stats view has two modes:

1. Roster Data mode loads player and pitcher totals from the Roster view.  The
Roster Data mode includes Batter

2. Scored Games mode compiles player and pitcher totals from game scored in
ScorePAD.

You can select any subview at anytime by selecting one of the tabs at the
bottom of the Stats view.  The tabs are:

1. Team batting Season batting and defensive statistics
2. Day by Day Batting Day by day batting and defensive statistics
3. Home Runs Day by day home runs
4. Team Pitching Season pitching statistics
5. Day by Day Pitching Day by day pitching statistics
6. Games Day by day game totals

With each subview you can:

q Sort statistics by any category by clicking the column heading
q Print the statistics as they are sorted
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q Copy statistics to clipboard
q Configure subview statistics content and order
q Display statistics by date range

Loading a team

To load a team you must select the league of the team you want to load from
the league list toolbar.

Then select the team you want to load from the team list on the toolbar.

Once you select a league and a team, ScorePAD searches its desktop database
and compiles the stats from all of the games in which each player of the
selected team participated.  ScorePAD then displays the totals for each player in
the stats view.

Selecting a date range

Stats view start and end dates

You can select a date range for statistics you want ScorePAD to display in this
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view.  To select a date range you must use the tool bar and select a start date
and an end date.  You can change either date or both dates by editing the date
text or selecting the down arrow and picking a new date from the pop-up
calendar.  Once you select a new date, all statistics will reload and recalculate.

Displaying RosterPAD statistics

Data type selection

In addition to displaying statistics compiled from games scored, you can also
display year-to-date statistics stored in RosterPAD.  To display RosterPAD
statistics, select Roster Data from toolbar.

Since these statistics are totals, you won't have any day-by-day batting, pitching,
or home run statistics so those tabs disappear when you select RosterPAD
Stats from the toolbar.

Printing stats sheets

To a stats sheet on a team:

1. Load the team.
2. Select the desired subview
3. Select Print from the File menu.

ScorePAD will print stats subview in the same format that it appears on the
screen.

Configuring Batting and Pitching subviews

You can configure the content and order of statistics displayed on the Season
Batting, Season Pitching, Day-By-Day Batting, and Day-By-Day Pitching subviews.
ScorePAD has a convenient dialog that allows you to configure these subviews.

Select Select Stats from the Edit menu in the Stats view to display the
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Statistics Selection dialog.  This view is composed the following:

Statistics - List of statistics available but not displayed on the subview
Selected statistics - List of statistics to be displayed on the subview
Fixed columns - number of columns that don't scroll horizontally

Statistics selection dialog

Each subview contained a default set of statistics when you installed ScorePAD.
You can add, remove, or reorder statistics for each subview.

To add a new statistic:

1. Select the place in the Selected statistics list where you
want the new statistic to appear.

2 Select the statistic you want to add from the Statistics list
3 Press the > button to add the statistic
4 You can also double-click members of the Statistics list to

add them to the Selected statistics list.

Any statistic you add to the Selected statistics list will be removed from
Statistics list.



97

To remove a statistic:

Select the statistic you wish to move in the Selected statistics list.
Press the < button
You can also double-click any member of the Selected statistics list to
remove it.

All statistics removed from the Selected statistics list will be added to the
Statistics list.

To reorder selected statistics:

Select the statistic in the Selected statistics list you want to reorder.

Press the Move up button to move the statistic up in the order or press the
Move down button to move the statistic down in the order.

To change the number of fixed columns:

Click on the down arrow of the fixed column combo-box

Select the number of fixed column to which you wish to change.

You can change the number of fixed columns to values from 0 to 10.  Fixed
columns will be the left-most columns of the subview.  Fixed columns will not
scroll when you scroll horizontally in the subview.  Additionally, fixed columns
will not copy when you copy statistics to the Windows clipboard.

Subview statistics content and order are preserved for exporting, web page
creation, printing, and clipboard copying.

Copying statistics to the clipboard

You can copy statistics from any subview to the Windows clipboard.  This allows
you to paste this data to spreadsheets, word processors, and other applications
that retrieve data from the clipboard.

To copy data top the clipboard, select any combinations of columns and rows of
data in a subview then select Edit Copy.  This will place the selected data on the
Windows clipboard.  You can then switch to another application and paste the
data.  This function works very well with spreadsheets and graphing programs.
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Exporting statistics

You can export statistics from the batting and pitching subviews of the Stats
view.  When you exports statistics, ScorePAD creates a file containing all of the
data on the subviews you select.  Each included subview will be in a separate
file.  Each data element will be separated by separator you specify and each row
of data will be terminated with a carriage return followed by a line feed (CRLF).

To export data perform the following steps:

Select the subview from which you want to export data
Reconfigure the content and order of the data by selecting Edit Select
Stats..., if necessary
Select File Export statistics...
Edit the path, file name prefix, separator, and subviews for which you want file
generated in the Statistics export specifications dialog.
Press the Export files button.

ScorePAD will create the following files (assuming you kept the PlayerStats file
prefix):

PlayerStats.txt Team batting subview statistics
PlayerStatsPitcher.txt Team pitching subview
PlayerStats_DBD10Jones__C.txt Day by day batting subview

(one file for each player)
PlayerStatsPitcher_PDBD29Smoltz__J.txt Day by day pitching subview

(one file for each pitcher)

Changing export settings

Statistics export specification dialog

You can change export setting before you begin an export or during the export
operation.  To change the export settings before you next export, select File
Export settings...  The Statistics export specifications dialog will appear.
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In this dialog you can select the subviews for which you want to create export
files.  You can also specify the export file directory, prefix, and field delimiter.

Creating Web pages from the Stats view

You can create web pages from each batting and pitching subviews.  These web
pages will contain all data columns and rows of the subviews that they repre-
sent.  They will also contain hyperlinks that link them to each other.  The
hyperlink on the web pages you create will be:

Page Hyperlinks
Team batting Team pitching and day by day batting pages (each player)
Day by day batting Team batting
Team pitching Team batting and day by day pitching (each pitcher)
Day by day pitching Team pitching

To create batting and pitching web pages, select File Create team statistics
web...  The Web page specifications dialog will appear allowing you to change
the web page specifications.  In addition to specifying the path and file name
prefix for web pages, you can change the following specifications for each web
page:

Page title
Heading 1 text and font size
Heading 2 text and font size

You can include several variables in the title and heading lines.  You can also
include any additional HTML tags in the title text.  When you finish changing
specifications, press the Create pages button to create the web pages.

ScorePAD creates web pages in HTML format with hyperlinks inserted.  These
pages can be immediately uploaded to your website and used to browse your
team's performance.

Once you've setup your web page specifications, the process from HotSync to
Web should take less than ten minutes after each game.
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Changing Web page specifications

Web page specifications dialog

You can change web page setting before begin creating web pages or during the
web page creation process.  To change web page settings before you next
export, select File Web page settings...  The Web page specifications
dialog will appear.   In this dialog you can select the subviews from which you
want to create web pages.  You can also specify directory and file name prefix.

For each page, you can change the title and  heading text.  To change them,
press the appropriate button on the Web specification dialog.    The Web page
settings dialog will appear allowing you to change the heading and title strings.

You can include the following variables in the title, heading1 and heading 2 text:

&L League name
&T Team name
&S Statistics start date
&E Statistics end date
&P Player name (First initial and last name)
\n Newline
You can also include HTML tags in the title strings.  In fact, you can include up
to 10K of HTML in each heading.  ScorePAD doesn't check the HTML for
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errors so you should be careful.

Web page settings dialog

Team batting
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Stats subview descriptions

Team Team name
# Player number
Player Player name
AVG Batting average
G Games played
GS Games started
PA Plate appearances
AB Atbats
R Runs
H Hits
TB Total bases
2B Doubles
3B Triples
HR Home runs
SLG% Slugging percentage
OB% On base percentage
RBI Runs batted in
SH Sacrifice hits
SF Sacrifice flies
HB Hit by pitch
BB Base on balls (walks)
IBB Intentional walks
K Strikeouts
Kc Called strikeouts
SB Total stolen bases
STL2 Stole 2nd base
STL3 Stole 3rd base
STLH Stole home
CS Total caught steals
CS2 Caught stealing second
CS3 Caught stealing third
CSH Caught stealing home
PKOF1 Picked off 1st
PKOF2 Picked off 2nd
PKOF3 Picked off 3rd
SB% Stolen base percentage
GDP Ground into double plays
TP Triple plays
PAB Pinch atbats
PH Pinch hits
PHR Pinch home runs
PBI Pinch RBI
TC Total chances

PO Put outs
A Assists
DP Double plays
PB Passed balls
PB% Passed ball percentage
E Total errors
Ef Fielding errors
Et Error throwing
FLD% Fielding percentage
DI Defensive interference
Kd3 Dropped 3rd strike - out
Kd3O Dropped 3rd strike - on
FC Fielder's choice
FLYO Flyouts
FOULO Foulouts
GO Groundouts
LO Lineouts
IB Illegal batted ball
IF Infield flies
Kbf Bunt foul 3rd strike
OBSTR Obstructions
OFINT Offensive interference
ERRCH Reach on error
SPECINT Spectator Interference
CINT Catcher interference
PCHR Pitches received
STLON Stolen on
THO Thrown out

Day by day batting
Gm Game number
Date Game date
Opponent Opposing team
H/R Home or road game
D/N Day or night game
# Player number
Player Player name
ORD Batting order
G Games played
GS Games started
+AVG Cumulative Batting average
Day by day batting continued
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PA Plate appearances
AB Atbats
R Runs
H Hits
TB Total bases
2B Doubles
3B Triples
HR Home runs
RBI Runs batted in
SH Sacrifice hits
SF Sacrifice flies
HB Hit by pitch
BB Base on balls (walks)
IBB Intentional walks
K Strikeouts
Kc Called strikeouts
SB Stolen bases
STL2 Stole 2nd base
STL3 Stole 3rd base
STLH Stole home
SB% Stolen base percentage
CS Total caught steals
CS2 Caught stealing second
CS3 Caught stealing third
CSH Caught stealing home
PKOF1 Picked off 1st
PKOF2 Picked off 2nd
PKOF3 Picked off 3rd
GDP Ground into double plays
TP Triple plays
TC Total chances
PO Put outs
A Assists
E Total errors
Ef Fielding errors
Et Error throwing
DP Double plays
FLD% Fielding percentage
POS Defensive position
Score Final score
Inn Innings played
AVG Batting average

SLG% Slugging percentage
OB% On base percentage
PAB Pinch atbats
PH Pinch hits
PHR Pinch home runs
PBI Pinch RBI
PB Passed balls
PB% Passed ball percentage
Kbf Bunt foul 3rd strike
CINT Catcher interference
DI Defensive interference
Kd3 Dropped 3rd strike - out
Kd3O Dropped 3rd strike - on
FC Fielder's choice
FLYO Flyouts
FOULO Foulouts
GS Games started
GO Groundouts
IB Illegal batted ball
IF Infield flies
LO Lineouts
OBSTR Obstructions
OFINT Offensive interference
PCHR Pitches received
ERRCH Reach on error
SPECINT Spectator Interference
STLON Stolen on
Team Team name
THO Thrown out
PCHR Pitches received
+FLD% Cumulative fielding %
+OB% Cumulative on base %
+PB% Cumulative passed ball %
+SLG% Cumulative slugging %
+SB% Cumulative stolen base %
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Stats subview descriptions - continued

Team pitching
# Player number
Player Player name
W-L Won-Loss record
G Games played
GS Games started
CG Complete games
SHO Shut outs
GF Games finished
SV Saves
SVO Save opportunities
IP Innings pitched
TBF Total batters faced
TAB Total atbats
H Hits
R Runs
ER Earned runs
HR Home runs
RBI Runs batted in
BB Base on balls (walks)
IBB Intentional walks
K Strikeouts
Kc Called strikeouts
K% Strikeout %
FPS First pitch strikes
FPS% First pitch strike %
KW% Strikeouts to walks %
WP Wild pitches
BK Balks
HB Hit by pitch
SH Sacrifice hits
SF Sacrifice flies
OPPAVG Opponents average
2B Doubles
3B Triples
SB Stolen bases
SBA Stolen base attempts
SB% Stolen base %
AP Pitches ahead in count
BP Pitches behind in count
EP Pitches from even counts
B Balls
S Strikes

F Piches Fouled off
POA Pickoff attempts
NP No pitches
I Pitches put inplay

Day by day pitching
Gm Game number
Date Game date
Opponent Opposing team
H/R Home or road game
D/N Day or night game
Score Final score
+ERA Cum earned run average
ERA Earned run average
W-L Won-Loss record
CG Complete games
SH Shut outs
SV Saves
SVO Save opportunities
GF Games finished
+GF Cumulative games finished
+GS Cumulative games started
IP Innings pitched
TBF Total batters faced
TAB Total atbats
H Hits
R Runs
ER Earned runs
HR Home runs
BB Base on balls (walks)
IBB Intentional walks
K Strikeouts
Kc Called strikeouts
KW% Strikeouts to walks %
K% Strikeout %
FPS First pitch strikes
FPS% First pitch strike %
+FPS% Cumulative FPS%
WP Wild pitches
BK Balks
HB Hit by pitch
SH Sacrifice hits
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Day by day pitching continued
SF Sacrifice flies
OPPAVG Opponents average
+OPPAVG Cumulative Opp average
# Player number
Player Player name
2B Doubles
3B Triples
SB Stolen bases
SBA Stolen base attempts
SB% Stolen base %
+SB% Cumulative stolen base %
W-L Wins and loses
AP Pitches ahead in count
BP Pitches behind in count
EP Pitches from even counts
B Balls
S Strikes
F Piches Fouled off
POA Pickoff attempts
NP No pitches
I Pitches put inplay
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Stats subview descriptions - continued

Home runs

Gm Game number
Date Game date
Opponent Opposing team
H/R Home or road game
D/N Day or night game
Player Batter that hit home run
HR Home run number
Pitcher Pitcher home run hit against
Count Ball and strike count when hit
Inn Inning of home run
Runs Number of runs scored

Games

Gm Game number
Date Game date
Opponent Opposing team
H/R Home or road game
D/N Day or night game
Score Final score of game
W/L Win or Lose
Record Running record of team
Stndg Standing of team after game
Gms 1st Games from first place
Winning pitcher Pitcher award the win
Losing pitcher Pitcher charged with lose
Save pitcher Pitcher credit with save
Duration Duration of game in hours and minutes
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File formats
All import formats require fields in the order below.  You don't have to include
all fields as long as the ones you do include are right order and contain the
information in the right format.

Each line end with a carriage return followed by a line feed
Each field must be separated by a comma
Each character field must be inclosed in double quotes (")

RosterPAD Import/Export file format

# Name Format Restrictions Description
1. Last name char up to 15 chars
2. First name char up to 15 chars
3. League char up to 16 chars
4. Team char up to 8 chars
5. Number numeric 0-99
6. Physical char
7. Bats char R, L, or S
8. Throws char R or L
9. Batting order numeric 0-16
10. Position numeric 0-14
11. Address char
12. City char
13. State Zip char
14. Phone char
15. Notes char
16. G numeric Games played
17. GS numeric Games started
18. PA numeric Plate appearances
19. Atbats numeric Atbats
20. R numeric Runs
21. H numeric Hits
22. 2B numeric Doubles
23. 3B numeric Triples
24. HR numeric Home runs
25. RBI numeric Runs batted in
26. K numeric Strikeouts
27. Kc numeric Called strikeouts
28. SB numeric Stolen bases
29. SH numeric Sac hits
30. SF numeric Sac flies
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RosterPAD fields continued

Field Format Restrictions Description
31. HBP numeric Hit by pitch
32. BB numeric Base on balls
33. IBB numeric Intentional base on balls
34. CS numeric Caught steals
35. GDP numeric Ground into double play
36. A numeric Assists
37. PO numeric Putouts
38. DP numeric Double plays
39. E numeric Errors
40. PB numeric Passed balls
41. PAB numeric Pinch atbats
42. PH numeric Pinch hits
43. PRBI numeric Pinch RBI
44. PHR numeric Pinch home runs
45. G numeric Games as pitcher
46. GS numeric Games started as pitcher
47. SHO numeric Shutouts
48. W numeric Wins
49. L numeric Loses
50. S numeric Saves
51. SVO numeric Save opportunities
52. FG numeric Finished games
53. ND numeric No decisions
54. IP numeric 1.1 = 1-1/3 Inn Innings pitched
55. BF numeric Batters faced
56. AB numeric Atbats
57. H numeric Hits given up
58. HR numeric Homers given up
59. ER numeric Earned runs
60. R numeric Total runs
61. BB numeric Walks
62. IBB numeric Intentional walks
63. K numeric Total strikeouts
64. Kc numeric Called strikeouts
65. WP numeric Wild pitches
66. BK numeric Balks
67. HB numeric Hit batsmen
68. SBA numeric Stolen base attempts
69. SB numeric Stolen bases
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Game export file format

The export file for games contains position player and pitcher statistics for
each player and each team - position player statistics first, then pitcher statis-
tics.

A line of field titles will precede each team's players.  After the position player
statistics, will appear the word Pitchers on a single line followed by a line of
pitcher statistics titles.

Exported position player statistics

# Name Format Restrictions Description
1. Team char up to 8 chars Team name
2. Name char Player name
3. Order numeric Batting order
4. Pos char Position
5. Inn numeric 1.1 = 1-1/3 Inn Innings at position
6. PA numeric Plate appearances
7. AB numeric Atbats
8. R numeric Runs
9. H numeric Hits
10. TB numeric Total bases
11. 2B numeric Doubles
12. 3B numeric Triples
13. HR numeric Home runs
Other on base
14. FC numeric Fielder's choice
15. ERRCH numeric Reached on error
16. DEFINT numeric Defensive interference
17. OBSTR numeric Obstruction
18. RBI numeric Runs batted in
19. SH numeric Sac hits
20. SF numeric Sac flies
21. HBP numeric Hit by pitch
22. BB numeric Base on balls
23. IBB numeric Intentional base on balls
Base running
24. STL2 numeric Stole 2nd
25. STL3 numeric Stole 3rd
26. STLH numeric Stole home
27. CS2 numeric Caught stealing 2nd
28. CS3 numeric Caught stealing 3rd
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29. CSH numeric Caught stealing home
30. PKOF1 numeric Picked off at 1st
31. PKOF2 numeric Picked off at 2nd
32. PKOF3 numeric Picked off at 3rd
Other offense
33. K numeric Total strikeouts
34. Kc numeric Called strikeouts
35. SB numeric Stolen bases
36. CS numeric Caught stealing
37. GDP numeric Ground into double play
Errors
38. ET numeric Throwing errors
39. EF numeric Fielding errors
Outs
40. GO numeric Groundouts
41. LO numeric Lineouts
42. FLYO numeric Flyouts
43. POPO numeric Popouts
44. FOULO numeric Foulouts
45. TP numeric Triple plays
46. IF numeric Infield flies
47. KBF numeric Bunt foul 3rd strike
48. OFINT numeric Offensive interference
49. ILLBAT numeric Illegal batted ball
50. BPV numeric Basepath violation
51. SPECINT numeric Spectator interference
Pinch hitting
52. PAB numeric Pinch atbats
53. PH numeric Pinch hits
54. PHR numeric Pinch home runs
55. PRBI numeric Pinch RBI
Defense
56. PO numeric Putouts
57. A numeric Assists
58. DP numeric Double plays
59. PB numeric Passed balls
Catcher
60. PCHR numeric Pitches received
61. STLON numeric Stolen on
62. THO numeric Thrown out
63. CINT numeric Catcher interference
64. Kd3 numeric Dropped 3rd strike - on-base
65. Kd30 numeric Dropped 3rd strike - out
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Exported pitcher statistics

# Name Format Restrictions Description
1. Team char up to 8 chars Team name
2. Name char Player name
3. IP numeric 1.1 = 1-1/3 Inn Innings pitched
4. H numeric Hits
5. AB numeric Atbats
6. BF numeric Batters faced
7. R numeric Runs
8. ER numeric Earned runs
9. 1B numeric Total bases
10. 2B numeric Doubles
11. 3B numeric Triples
12. HR numeric Home runs
13. SH numeric Sac hits
14. SF numeric Sac flies
15. HB numeric Hit batsmen
16. BB numeric Base on balls
17. IBB numeric Intentional base on balls
18. K numeric Strikeouts
19. Kc numeric Called strikeouts
20. WP numeric Wild pitches
21.. BK numeric Balks
22. B numeric Balls
23. S numeric Strikes
24. Sc numeric Called strikes
25. F numeric Fouls
26. POA numeric Pick off attempts
27. NP numeric No pitches
28. I numeric Balls put in play
29. FPS numeric First pitch strikes
30. BP numeric Pitches behind in count
31. EP numeric Pitches from even counts
32. AP numeric Pitches ahead in count
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